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IJWS

This quickstart will help you set up your MS Windows machine to explore the sourcecode of
Bonsai or develop and debug your blender scripts in VSCode. This has the benefit of having a
complete development environment where you can explore the code, make changes, debug
(break-points, watch variable and stack contents, etc. ) and see the results in blender

e Steps 1-6 will get you started with VSCode to develop and debug python scripts in Blender.
e Steps 7-14 will allow you to interact with GitHub to make changes to the Bonsai project.

We will be using AlmalLinux 9 as our operating system and Visual Studio Code as our
Integrated Development Environment (IDE) and we will create a dedicated user for
Development.

1. Create Development User: Open Windows Settings (typically hitting “Windows” key and
writting “settings” in the search field) and then go to (Accounts » Other users]. Click on |Add
account|and then add a new user. We will name it falken10vdl

di Accounts > Other Users

v
falken10vdi@gmail.com

Find a setting ¢

& Home
B System
B Bluetooth & devi
B Microsoft

Create account

someone@example.com

a new email address

Add a user without a Microsoft account

Terms of Use  Privacy & Cookies

2. Install Blender for the created user: We will install blender locally in the users home
directory. We must check that we are following the Systems requirements.

We will download Blender 4.2 from the Blender download page. In particular, we take the
4.2 LTS for Windows.

We will download the Windows - Portable (.zip) version:

https://www.blender.org/download/release/Blender4.2/blender-4.2.8-windows-x64.zip
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Unzip the file in the user home directory. In our case it is C:
|\Users\falke\Documents\blender-4.2.8-windows-x64 (the user falken10vdl has as home
directory C:\Usersl\falke).

Congratulations! You have now Blender installed locally in your machine. You can launch it by
double clicking in blender.exe which is situated in the previous folder.

Now install the Bonsai Blender extension. Follow the Unstable installation.

Congratulations! You have now the Bonsai Blender extension installed in your local Blender
installation.

3. Install VSCode: Log in as the new created user (falken10vdlin this example) and install
Visual Studio Code.

4. Adjust Python version in VSCode as in Blender: This is a good practice step to ensure that
the Python version in VSCode matches the one in Blender.

Check the Python version in Blender by going to |Scripting|. In the Python Console you can
see the version number of the Python interpreter

(Unsaved) - Blender 4.2.7 LTS

Help R

Select Add Object 7 Global v (v v View @ + New @& Open

Options v

Render Engine  EEVEE

" v sampling

Samples
> ¥ Shadows
> Advanced

> Clamping

In our case it is version 3.11.7

We will need to install the closest version in our Linux machine.

We check in either in Microsoft store or Python Downloads.

The closest version is 3.11 in Microsoft Store. So we installing by clicking in .

After this, we have the 3.11 python version installed in our machine. It is reachable by typing
python3.11 in the terminal.
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python3.11 -V

Command Prompt

C:\Users\falke>python3.11 --version
Python 3.11.9

C:\Users\falke>

Launch VSCode and go to the Extensions tab, search for Blender Development and install it.

) Walkthrough: Setup VS Code X

5 | Blender Development v0.0.25

Get Started with VS Code

Use Al features with Copi

SetUp Copilot for Free

BlendpyBridge

DCC Websocket

This will also install some Python related extensions.

Finally create a sample python file and check the Python interpreter version in the bottom left
corner. Select the Python interpreter that matches the one in Blender. In our case it is 3.11.

File - New File... » Python File

i t t Select Interpreter

@ EXPLORER

v NO FOLDER OPENED -+ Create Virtual Environment
B3 Enter interpreter path.
You have not yet opened a folder
{23 Use Python from "python.defaultinterpreterPath’ setting
Open Folder Python 3.13.2 64-bit C:\Python313\python.exe
Python 3.11.9 64-bit (Microsoft Store)

Opening a folder will close all currently opeiTcarore 1o Recp

Recommended
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You can clone a repository locally.
Clone Repository
You can open a remote repository or pull request without cloning,

Open Remote Repository

To learn more about how to use Git and source control in VS Code

> OUTLINE

> TIMELINE

X ®oAO0 In1,Col1 Spaces:4 UTF-8 CRLF {}|Python 3.13.2 64-bit |
Congratulations! You have now a Python version in VSCode similar to the one run by Blender.

5. Connect VSCode to Blender by means of VSCode’s extension: “Blender Development”:

This steps is crucial to be able to develop and debug scripts in VSCode ans interactivwely
see the results in Blender.

Launch VSCode and go to the Extensions tab, search for Blender Development and install it.

) Walkthrough: Setup VS Code X

5 | Blender Development 10.0.25

[Experimental Fork]

code Blender Python SAFRTR @6 Get Started with VS Code

; ST LR
vscode_blender_nokto
Blender mojo theme
Jca i

SetUp Coplot for Free
[ ——

lsta p
BlendeyBridge

DCC Websocket

en Jungle theme
h

)

Dark Plus Moon light
moondevas
shades of midnight blue dark theme
moondevas

Moon Violet Dark Plus
DarkPlus Chocolate

G Blends

I RIS

This will also install some Python related extensions.

Finally create a sample python file and check the Python interpreter version in the bottom left
corner.

File » New File... » Pvthon File
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Select Interpreter

@ EXPLORER

v NO FOLDER OPENED -+ Create Virtual Environment.

B3 Enter interpreter path.
You have not yet opened a folder
: {23 Use Python from "python.defaultinterpreterPath setting
Open Folder Python 3.13.2 64-bit C:\Python313\python.exe Recommended

Python 3.11.9 64-bit (Microsoft Store)
Opening a folder will close all currently operi editors. 10 ke

ep
them open, instead

You can clone a repository locally.
Clone Repository
You can open a remote repository or pull request without cloning.
Open Remote Repository

To learn more about how to use Git and source control in VS Code

> OUTLINE

> TIMELINE
» ®oA0

6. Test that you can develop python scripts in VSCode for Belnder: Create a sample blender
python file under adirectory for example C:\Users\falke\Documents\bonsaiDevellscripts. You
can use whatever blender python script you want. We will use this one from the blender

documentation:

Example Panel

import

class HelloWorldPanel( . . ):
"""Creates a Panel in the Object properties window"""
= "Hello World Panel"
= "OBJECT_PT_hello"
= 'PROPERTIES'
= 'WINDOW'

= "object"

def draw(self,
= self.

0
="Hello world!", ="WORLD_DATA")

@)

="Active object is: +
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, unamen)

Q)

("mesh.primitive cube add")

def register():

def unregister():

if == "__main__"
print("Hello World: run from Blender Text Editor")
else:
print("Hello World: run from VSCode")
print(f"NOTE. _ name__ is : { )

Q)

We have changed the last part of the script since running from VSCode has some subtle
diferences compared to running from the Blender Text Editor. In particular the special
variable __name__ is different.

Press CTRL-SHIFT-P and type “Blender: Open Scripts Folder”. Select the previous folder
where the script file is located

Press CTRL-SHIFT-P and type “Blender: Start”. Blender will start.

Press CTRL-SHIFT-P and type “Blender: Run Script”. The script will run and the output will
be seen in Blender!

As you can see below. We have set a break-point in line 37 (see point 13 below for another
example of setting a break-point). We can inspect in the left side the local variables, global
variables, add watches, check the stack, etc. For example we can see that __name__has a
value of “<run_path>" Instead of “__main__".

RUN AND DEBUG D BonsaiDocsServer (IfcOpenShell) v £}

v VARIABLES

v Locals

draw(self, context):

layout = self.layout
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j = context.object

v = layout.row()
v.label(text="Hello world!", WORLD_DATA")

v = layout.row()

v.1label (text="Active object is + obj.name)
v = layout.row()

v.prop(obj, "name")

v = layout.row()

v.operator(“mesh.primitive_cube_add"

register():
bpy.utils.register_class(HellolWorldPane

unregister():
bpy.utils.unregister_class(Hellokorl

if __name__ == "_ main__
print(“Hello World
print("Hello Worlc

print(

register()

v WATCH

> CALL STACK
“ BREAKPOINTS
B Raised Exceptions
¥ Uncaught Exceptions
B User Uncaught Exceptions

¥ example.py

Once we continue execution we can check in the VSCode Terminal the output and in Blender

the panel created by the script.

row. label (text= s: " + obj.name)
row = layout.row()
row.prop(obj, "name")

row = layout.row()
row.operator (“mesh. primitive_cube_add")
 Transform
Location X
register(): . -
bpy.utils.register_class(HellohorldPanel L z
Rotation X
. . Y
unregister() .
bpy.utils.unregister_class(He
Mode
Scale X

if _name_ ==

> Delta Transform
> Relations

> Collections
register()
4

> Instancing
> Motion Pathe

> Visiilt

© Hallo World Panal
© Holoworid!
Active object s: Cube

Name: Cube

Add Cube
> Viewport Display

> Line Art

> Custom Properties

DEBUG CONSOLE

©- Playback v Keying v View Marker O Hecqd Pre 1 & s 1 End 250
1 2 ) Y o 120 1 ” E

CONGRATULATIONS! You have now a development environment ready to speedup your
python scripting in Blender.

Now let’s find out how to interact with GitHub in order to make chanaes to the Bonsai proiect.
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7. Install GitHub related VSCode extensions: To facilitate the use of git commands and pulling
and pushing files from a local repository towards github, please install as well the following
VSCode extensions:

o GitHub Pull Requests
o GitHub Repositories

o Remote Repositories

Optionaly you can also install Copilot extensions

o GitHub Copilot
o GitHub Copilot Chat

] File Edit Selection View Go Terminal

v INSTALLED

Blender Development

GitHub Copilot

& GitHub

GitHub Copilot Chat

& GitHub

GitHub Pull Requests
£ GitHub

GitHub Repositories
Q tHub

Pylance

Python
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I Microsoft

Python Debugger
e £ Microsoft

Remote Repositories

£ Microsoft

8. Fork IfcOpenShell project from GitHub: For this step you will need an account on GitHub.
Once you have a registered account you can find it under https://github.com/
YOURGITHUBUSERID In the example for falken10Ovdl the link is https://github.com/
falken10vdl

= O falken10vdl Q Type (/]to search

[0 overview ] Repositories 1 [ Projects @ Packages ¥¥ Stars 1

You unlocked new Achievements with private contributions! Show them off by including private contributions in your Profile
in settings
Popular repositories

Spoon-Knife

Forked from octocat/Spoon-Knife
This repo is for demonstration purposes only

HTML

falken10vdl 25 contributions in the last year Contribution settings ~

Go to the IfcOpenShell GitHub page. And click on the Fork button. Please make sure that you
are logged with your GitHub account as shown in the top right corner of the page.

« - C O B https://github.com/IfcOpenShell/IfcOpenShell ® 0 O v ® =

= O IfcOpenShell / IfcOpenShell 2 (7]t B + - O 1N B8 .
——

<> Code (©) Issues 959 I} Pullrequests 32 L) Discussions () Actions [ Projects 2 00 wiki @ Security |~ Insights

:: IchPenShe” *) Sponsor <> EditPins ~ ® Watch 91 ~ % Fork 766 @ Y7 Star 2k
X

Existing forks

You don't have any forks of this repository.

iry and geometry

@ aothms Apply skew in infra loft 4 £0) 17,500 Commits engine

¥ v0.8.0 ~

g
55

B github
aws/lambda
choco/bonsai
cmake
conda

docs

nix ) ( F I 2 W 4 ‘ o
Releases 1,877
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bonsai-0.8.2-alpha2503201130 ...

Once the fork is generated you will be redirected to your own fork of the IfcOpenShell
project.

€« > C O B https://github.com/falke

O[ falken10vdl IchpenSheIII

<> code {7 Pullrequests () Actions [ Projects [0 Wiki © Security |~ Insights &3 Settings

. IfcOpenShell £ Pin ©Watch 0 ~

forked from

<> Code ~ About

Open source IFC library and geometry

This branch is up to date with 1fco IfcC v - I3 Contribute ~ & Syncfork ~ engine

o
@ aothms Apply skev ) ) 17,500 Commits &

B github
B aws/lambda

B8 choco/bonsai

Now we will clone the forked repository to our local machine.

9. Clone bonsai to our development environment: Launch VSCode Select the Source Control

tool. Then |Clone repository| and then select “Clone from GitHub”.

® Clone from Githiub

Visual Studio Code
Editing evolved

Start Walkthroughs

L ) i Get Started with VS Code
D opentie o et e

he basics, and start coding @

% clonecitn @ GitHub Copilot (e Welcome to Copilot

wse & Edit Remote Repositories without Cloning (8

Recent @ Get Started with Python Development [New
Youhave no recent foders,opena

@ Get Started with C++ Development [NeW

A series of steps will be required to authenticate with GitHub. You will need to provide your
GitHub credentials. Once VSCode has authenticated yourself in GitHub, you will be able to
select the repository you want to clone. In this case we will clone the [fcOpenShell
repository.
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Visual Studio Code

Editing evolved

VSCode will ask you to select a folder where the repository will be cloned. and it will start
the cloning process.

Once finished, you will see the repository in the Explorer tool.

Visual Studio Code

10. Link the Bonsai addon to the local cloned repository: We will now edit the following script
that establishes links from the unstable-installation to the cloned repository so we can easily
see the changes done in the cloned repository taken effect when we load blender locally.

Download dev_environment.bat

Edit the file to match the paths in your system. In our case we will edit the following lines:

o SET REPO_PATH=%HOMEDRIVE%\Users\%USERNAME%
\Documents\bonsaiDevel\IfcOpenShell

o SET BLENDER_PATH=%HOMEDRIVE%\Users\%USERNAME%
\AppData\Roaming\Blender Foundation\Blender\4.2

o SET PACKAGE_PATH=%BLENDER_PATH%\extensions\.local\lib\python3.11\site-
packages

o SET BONSAI_PATH=%BLENDER_PATH%\extensions\raw_githubusercontent_com\bonsai

You need to run it as an administrator. We execute the script in the terminal. Confirm the data

and the script will create the necessary links.
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IC: \Users\falke\Documents\bonsaiDevel>.\dev_environment.bat

Make sure you have followed these steps before proceeding :
Currently set paths:

Please review if the following is right:
PUD: C:\Users\falke\Documents\bonsaiDevel
\IfcOpenshell): C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell
BLENDER PATH: C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2
PACKAGE PATH (.....\extensions\.local\lib\python3.11\site-packages): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages
BONSAI PATH (.....\extensions\raw_githubusercontent_com\bonsai): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\raw_githubusercontent_com\bonsai

Press any key to continue .
IChanging to the Git repository directory.
"*.s0' already exists in .gitignore
Copy over compiled IfcOpenshell files...
C: \Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcopenshell\ifcopenshell_urapper.py
C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcopenshell\_ifcopenshell wrapper.cp311-win_amd64.pyd
2 file(s) copied.
Remove extension and link to Git...
C: \Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcopenshell\_ifcopenshell wrapper.cp311-win_amd6d.pyd - Access is denied.
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\raw_githubusercontent_com\bonsai\__init__.py <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bonsai\bon
sai\_init__.py
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bonsai <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bonsai\bonsa
i

Cannot create a file when that file already exists.

symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifccsv.py <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifccsv\if
ccsv.py

symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcdiff.py <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcdiff\
ifcdiff.py

symbolic link created C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bsdd.py <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bsdd\bsdd.p

link created Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bcf < > C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bcF\bcf
link created Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcad <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcad\ifcdd
link created :\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifc5d <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifc5d\ifcsd
Link created \Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifccityjson < > C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifccity
json\ifccityjson
symbolic link created :\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcclash <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcclash\i
fcclash
symbolic link created :\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcpatch <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcpatch\i
fcpatch
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifctester <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifctester
\ifctester
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcfm <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcfm\ifcfm
Manually downloading some third party dependencies...
% Total % Received % Xferd Average Speed Time  Time Time Current
Dload Upload Total Spent  Left Speed
1ee 228k 100 228k e 2646k e -- = S -- 2685k
% Total % Received % Xferd Average Speed Time Time Time Current
Dload Upload Total Left Speed
160 18913 166 18913 e e 524k e -- = H 543k
% Total % Received % Xferd Average Speed Time i Time Current
Dload Upload Total Left Speed
e e e e e e e 9 --:i--:-- H -3 -- e
Warning: Failed to open the file C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bonsai\bim\schema\Brick.ttl: No such file or directory
@ 1726k e e H e
curl: (23) client returned ERROR on write of 4134 bytes
Press any key to continue .

C: \Users\falke\Documents\bonsaiDevel>

Warning

If you receive errors like this:

The system cannot find the path specified.

It means that you have not installed the Bonsai Blender extension. Please refer to tha last part of point 2. above
and follow the Unstable installation.

11. Adjust the VSCode Blender extension: We will now make some adjustments to the VSCode
Blender extension to ease the reload of the addon. Select the Extensions tool. Then |Blender
Development| and then select |Settings|.

File Edit Selection View Go Run -+« O IfcOpenShell BEO0Dd0 - O X

EXTENSIONS t ® T Settings gging.rst Ll =]

ext:JacquesLucke.blender-development 13 Settings Found =
q P! 9

v INSTALLED 5
User Workspace Backup and Sync Settings
Blender Development
Tools to simplify Blend
> Extensions
Jacques Lucke Blender: Additional Arguments
nal arguments used for Blender start-up. List of strings.
C/C++

++ Intel

& Microsoft

@

GitHub Copilot Disable

Your Al pair programme Disable (Workspace)

& GitHub

. Auto Update r > Addon: Build Task Name

GitHub Copilot Chat

Al chat fe ey @ at should be executed before the addon can be loaded into Blender.
GitHub

hd Install Specific Version...

GitHub Pull Requests Uninstall

Pull Request and Is c

r> Addon: Extensions Repository
& GitHub Copy

@066

extensions only: repository to use when developing addon
GitHub Repositories Copy Extension ID -> Preferences -> Get Extensions -> Repositories (dropdown, top right)

Remote and edit any G epositc Copy Link [ ——

& GitHub
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Settings

Pylance n to all Profiles r> Addon: Just My Code

Ape eature-ric e server for nVsC
ue, debug only the code in this addon. Otherwise, ernal python library code
LA Add to Recommendations

Click twice in “Add Item” within the Blender: Additonal Arguments section and add the
following two items (adapt Testing.ifc to the name of the IFC file you want to test during
Bonsai development):

o —python-expr

o import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\\bonsaiDevel\
\Testing.ifc”, should_start_fresh_session=True, use_detailed_tooltip=True)
< Settings X
@extJacquesLucke.blender-development 13 Settings Found ==

User Workspace Folder » Backup and Sync Settings

v Extensions (13)

&% | Blender: Additional Arguments

Blender (13) » X X
Additional arguments used for Blender start-up. List of strings.

--python-expr
import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\\bonsaiDevel\Testing.ifc", should_start_fresh_session=True, use_detailed_tooltip=Trugf X
Add Item

Warning

Note the double backslash in the path for correct interpretation by VSCode

Make sure that Blender > Addon: Just My code is not selected (This allows to set the
breakpoints anywhere in the source code).

@ext:JacquesLucke.blender-development 13 Settings Found = Y/

User Workspace Backup and Sync Settings

Blender > Addon: Just My Code

f true, debug only the code in this add
th ry code

Blender > Addon: Load Directory

& Microsoft
853 GitHub Copilot
& GitHub

Warning

This way to use the VSCode Blender extension is not the standard one. Refer to the VSCode Blender extension
documentation for the standard way to use it. The reasond behind is that this allows us to start VSCode in the
top of the cloned repository so all the Git related funtionality in VSCode works properly and we have a

complete view from VSCode tool of the whole repository.

Bonsai is a big project with a lot of dependencies so reloading it it is not an easy task (see discussion in https://
community.osarch.org/discussion/1650/vscode-and-jacquesluckes-blender-vscode/p1l). We have taken the
pragmatic approach to start blender with a specific file (Testing.ifc) and then we can reload the addon from the
Blender Ul which also upload automatically the changes in the addon and the testing file To summarize:
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o We need Blender > Addon: Just My code to get the breakpoint functionality even if the addon is not
“registered/loaded” to the extension (due to the root folder we use)

o We need Blender: Additonal Arguments to automatically load the Testing.ifc file when we start Blender
from VSCode (We do not use Blender:Reload Addons since it does not work in our case)

Instead of restarting Blender from VSCode, we use the Blender Ul that, as explainedin the next step, it provides
a simple way to get the addon and the Testing file reloaded.

12. Launch blender from VSCode: We are now ready to launch Blender from VSCode. Open

VSCode. Open the cloned repository if not already open. Press CTRL-SHIFT-P and type
“Blender: Start”.

) Eile

Walkthroughs

*
Started

GitHub Copilot (NeW

3 Bro

dit Remote Repos|

@ Get

OUTLINE

TIMELINE

Blender will start loading the Testing.ifc file. You can now start exploring the code and make
changes to the addon!

14 of 24
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In order to be able to restart blender (and reload the addons + reload teh lesting file) we
need to enable “Developer Extras” and also a good practice is to enable “Python Tooltips” in

Edit » Preferences » Interface|.

Interface
Viewport
Lights
Editing

Animation
Get Extensions

Add-ons

Themes

Input
Navigation

Keymap

System
Save & Load

File Paths

Experimental

Blender Preferences

v Display

Resolution Scale

Line Width

1.00
Default
+ Splash Screen

« Developer Extras

Tooltips

Search

v Editors

Color Picker Type
Header Position

Factor Display Type

> Temporary Editors

> Status Bar

v Language

Language

+ User Tooltips
+ Python Tooltips

+ Sort by Most Recent

+ Region Overlap

+ Navigation Controls
Circle (HSV)

Keep Existing

Factor

English (English)

Once these are enabled, you can press F3 and write restart to restart Blender.

R File Edit Render Window

v @ 0 v

& Scene Collection
& Collection Loy o]
v W IfcProject/Projekt-FZK-H @ © @
v & IfcBuildingStorey/Erdg @ © @
> W IfcAnnotation/Unn
IfcAnnotation/Unn
IfcAnnotation/Unn
IfcAnnotation/Unn
IfcAnnotation/Unn
IfcAnnotation/Unn
IfcAnnotation/Unn
n/Unn
n/Unn
nnotation/Unn
IfcAnnotation/Unn
IfcAnnotation/Unn
IfcBeam/Unterzug
IfcBuildingStorey/I
IfcDoor/Haustuer
IfcDoor/Innentuer
IfcDoor/Innentuer
IfcDoor/Innentuer
IfcDoor/Terrassen
IfcSlab/Bodenplati
IfcStair/Wendeltre
IfcWallStandardCe
StandardC:
StandardC:
StandardC:
StandardC:

(Unsaved) - Blender 4.2.8 LTS

#®v W ObjectMode v View Select Add Object 17 Global v (Pv §@ Mix v (&

A0

User Perspective
(1) IfcBuildingStorey/Erdgeschoss

SORANEY

\
w

A Yy @

= 4

S PR

0 rest|

BIM &5+ Scene o< @
I - @ 0 ©O@O® - @ IFC Object Mode v
Options

SoCcawrL I

@B Project Overview

ViewLayer

&5 Scene

v Project Info

] Testing.ifc Va
{% IFCSchema  IFC4
#1 IFCMVD , Quantity...ew]Option

1, Saved 2016-12-2117:54
-
> Git
+ Spatial
\ Spatial Decomposition

& Default: Erdgeschoss

IfcBuilding

{] Projekt-FZK-Haus
v & Gelaende
v 4 FZK-Haus
= ACID.
Flur

Buero
Bad
Schla
Wohn...
Kiiche
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IfcWallStandardC: der - Restart Blender L/
IfcWallStandardC: Restore Key Manfcl £
IfcWallStandardC: Clear All Rest  Blender will be immediately restarted, save your data first before running this operator. ~ gnts

IfcWallStandardC:
rrence

TfcWindow/EG-Fei \ Disable Editing Resource Time
TfcWindow/EG- Edit Representation Item Style
IfcWindow/EG- i Enable Editing Resource Time
IfcWindow/EG- Reference Structure

TfcWindow/EG- | Reload Drawing Styles  Project Setup
IfcWindow/EG- Remove Drawing Style
IfcWindow/EG-

IfcWindow/EG- Z

T 7 > buildingSMART Data Dictionary

4 Add Grids

> Project Library

> Links

TfcBuildingStorey/Dac! & > Classifications
TfcAnnotation/Unn > Libraries
TfcAnnotation/Unn c
onstraints
TfcBeam|First >

IfcBeam/Pfette-1 > Documents

TfcBeam/Pfette-2 > Property Set Templates
TfcBuildingStorey/l e—
TcMember/Sparre )

TfcMember/Sparre ol

TfcMember/Sparre > Georeferencing

TfcMember/Sparre > Geometric Representation Contexts
e > Space Boundaries
TfcMember/Sparre

TfcMember/Sparre e
TfcMember/Sparre + Grouping and Filtering
TfcMember/Sparre « Search
TfcMember/Sparre
TfcMember/Sparre
TicMember/Sparre + Add Search Group

IfcMember/Sparre

0 Saved Searches

- Filter Selection
IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre -y ey
TfcMember/Sparre > Select Similar
IfcMember/Sparre > Groups
IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

IfcMember/Sparre

TfcMember/Sparre

IfcMember/Sparre

13. Add a break-point: Let's add a break-point in the code to see how it works. Press
CTRL_SHIFT_P and type “Blender: Start”. Blender will start. Open the cloned folder and go

to src > bonsai > bonsai > bim > module > ligth > prop.py and go to line 75. Add a line for a

print statemente and click on the left side of the line number to add a break-point.

74  def update_shadow_mode(self,
75 print("Shadow mode", self.
76 if self. "SHADING" :

* (Unsaved) - Blender 427 LTS

8. ® ObjoctMode « View Select Add Object L Global v P Y Mx v [
T Telett
[y ——

5

update s
update

> 9

8 s

& S0 e
@

uTC Time:11.
¢ DisplaySu. Su. 5000
NoShads, @shace € Renc.

R VewFromsun

2R r=
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oooooo!

In Blender. Go To SOLAR ANALYSIS Tool in Bonsai and Click in “No Shadow”, “Shaded” or

“Rendered”

Render
. 0 W ObjectMode v View Select
e Collection 10
IfcProject/Projekt
B IfcBuildingstc @

IfcAnnotal

User Perspective
(1) IfcBuildingStorey/Erdgeschoss

IfcAnnotal

IfcAnnotal

nnota'
IfcAnnotal
IfcAnnotal

IfcAnnotal

'o' Scene
G SOOAmIEL
@B Project Overview

\ Grouping and Filtering

v Search

0 Saved Searches

+ Add Search Group

v Filter Selection

> Colour By Property

> Select Similar

No Configurations

VARIABLES

Locals

update
update

update
update

update
update

update
update

update

print("Sha

&5+ Scene s} &\ viewLayer [O

12 Global v (v § Mix v {- @ 3 85 scene

Options v

80O =T
M Services and Systems
v Services
> Systems
v Zones

0 Zones Found

v Solar Analysis
Sites: Gelaende - 49.1,8.437 v b
Coordinat. .", 49°06'01.56"N 08°26'11.5
Latitude 49.10 Longitude B.44
True North
Year
NELTTETY 1 Date
Hour 12 Minute
Europe/Berlin
Local Time: 12:00:00  Sunrise: 08:20:43

UTC Time: 11:00:00 Sunset: 16:39:18

* Display Sun Path Sun Path... 50.00

' NoShadows @ Shaded @) Rendered

2 View From Sun

v Lighting

> Radiance Exporter

— (o

LALLUNYSELT, LUIILEXL):

hourminute(self, context):
sun_path( )

date(self, context):
sun path( )

true_north(self, context):
sun_path( )

sun path size(self, context):
sun_path( )

shadow mode(self, context):
, .shadow mode)
.shadow_mode == A

update_sun_path(

context.scene.render.engine = LEND
context.scene.display.shading.light =
context.scene.display.shading.show shadows =
context.scene.display.shading.show object outline =
context.scene.display.shadow focus = 1.0
context.scene.view settings.view transform =

space = tool.Blender.get view3d space()
space.shading.type = "RENDER
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14.

un_object
light add(typ SUN", radius=1, align="WOF
bpy.ops.object.move to collection(collection index=0)
context.scene.sun_pos_properties.sun_object = bpy.context.a
update sun_path(
context.scene.render.e 2 BLENDER EEVEE NEXT

WATCH :: 0.0 g bash

() blen...

:: 0.00
: 0.00

:: 0.00

CALLSTACK

wread_function)

run_simple
run

server_thread_function

BREAKPOINTS

Import finis
Warning: File written by

From here you can watch the local variables, global variables, add watches, check the stack,
etc. Resume execution or move step by step to see how the code is executed.

CONGRATULATIONS! You have now a development environment ready to explore the Bonsai
code and contribute to the project.

Make changes and do a Pull Request to the project: In the previous steps we got a
complete IDE to explore and make changes to the Bonsai sourcecode. In this step we will
provide a simple workflow of using Git commands within VSCode to make changes and do a
Pull Request to the project. Bonsai changes very fast so our cloned repository will be
outdated very soon. We propose to do the following:

a. Check in our GitHub page if our project fork (https://github.com/falken10vdl/IfcOpenShell)
is outdated compared to the IfcOpenShell main branch (https://github.com/lfcOpenShell/
lfcOpenShell).

b. Sync our fork with the upstream branch (if needed).

c. Pull the changes in our porject fork to our local repository (/home/falken10vdl/
bonsaiDevel).

d. Create a new branch in our local repository (example: DOC_QS_/DE)
. Publish the branch to our project fork in GitHub.

D

f. Make changes in the code.

. Commit the changes.

3> Q@

. Push the changes to our project fork.

i. Create a Pull Request to the upstream main branch of the [fcOpenShell project.

[ . [ 1 ot . cat 1 o . ot [ .o o ~ -
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LeUsS see pbelow the STteps WITh an example oT changing the documentaton oT the WuIcKstart
guide for the IDE in Linux.

a. Check in our GitHub page if our project fork is outdated. Click Update branch

« > C

= O falken10vdl

(> Code

IfcOpensShell

I} Pull requests

@ IfcopensShell

forked from

¥ v0.8.0 ~ ¥ 1Br

® Actions

% itpsilgthub coalkeniovlcOpenshell

3 Projects [

Wiki ) Security 2 Insights

This branch is

i) Contribute ~

.github
aws/lambda
choco/bonsai
cmake

conda

docs

nix

pyodide

« > C

O falken10vdl

<> Code

O 8 https
IfcOpenShell

1 Pull requests

@ IfcopenShell

forked from

This branch is up to date with

») Actions

te This branch is out-of-date

& Settings

®Watch 0 ~

t + <> Code ~ About

Open source IFC library and geometry

& Syncfork ~ engine

m

Compare
Releases

Update branch

github.com/fal

f Projects [0 Wiki ) Security Insights

Edit Selection View Go Run Terminal

SOURCE CONTROL

> CHANGES
~ GRAPH B Ifcopenshell §9 Aute @
Apply skew in infra lofts #6386

ISSUE #6328 patch_token to a

it info from underlying

ifcsverchok - remo
node.sv_ifc_tooltip - hide title
typing

Read settings from argparse

Help IfcOpenShell

prop.py M = Settings X

@ext:JacquesLucke.blender-development

User Workspace

Blender: Additional Arguments

{1 Contribute ~

Packages

o3 Settings

<> Pin ®Watch 0 ~

<> Code ~ About

Open source IFC library and geometry

O Syncfork ~ engine

DO - o x
o -
13 Settings Found =

Backup and Sync Settings

Additional arguments used for Blender start-up. List of strings.

python-expr

import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vd|/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool

Add Item

d. Create a new branch in our local repository by clicking in the current branch name in the
bottom left corner of the VSCode window. Give a name to the branch and press Enter.

) File Edit Selection View Go Run Terminal

M SOURCE CONTROL

> CHANGES

)\ GRAPH ElifcOpenshell §° Auto @

.S

Help

DOC_QS_IDE

=+ Create new branch...
~+ Create new branch from...

Y30 & Checkout detached..

o@D - o X
o8 -

13 Settings Found =%
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Fix Blender 4.4 errors starting some operators. .
9 P User Workspace Backup and Sync Settings

The experimental cutting tool now supports a bisect mode fo..
Minor fix to clipping planes if there is no camera Dion Mou  Extencions N
See #6404, See #1227. Create axis context if it does not exist ———— Blender: Additional Arguments

ender (13)
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall . Additional arguments used for Blender start-up. List of strings.
Some form of circle handling in loop_to_function_item_upgr.

Apply skew in infra lofts #6386 Tho

~-python-expr

import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool|
ISSUE #6328 fix in dispatch_token to avoid missing unknown

Retrieve length unit info from underlying mapping in iterator . Add Item
ifcsverchok - ifc.write_file_panel to filter.ifc files An

node.sv_ifc_create_file_refresh - fix LB Out bl_label A
Blender > Addon: Build Task Name
ifcsverchok - remove debug print And
Task that should be executed before the addon can be loaded into Blender
node.sv_ifc_tooltip - hide title
typing A 3
Read settings from argparser

pyodide demo: install shapely Thomas Blender > Addon: Extensions Repository
Update publish-pyodide-demo-app.yml
Update wheels #6402 Thomas Krijne

Blender 4.4 - fix broken Ul lists #6396... And

Blender extensions only: repository to use when developing addon.

Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)
Implement readable setting type retrieval T i o ey eopment
Reinstate old bespoke model-offset/rotation parsing in IfcCo...
Normalize model-rotation quaternion Tk j Blender > Addon: Just My Code

Bonsai makefile - fill last_commit_date... Andrej73 If true, debug only the code in this addon. Otherwise, allow stepping into external python library code.
Fix missing default value for "last_commit_date" (37ec2bf) #...

Use explicit *bl_ui_utils.layout" import to fix #6389... Anc

debugging docs - add section about debugging addon Ant i st e el ey

get distance along alignment from station o Br Directory that contains the addon that should be loaded into Blender.
See #1227. Fix bug where unjoin walls didn't recheck the posi. auto

Fix #6318. Fix warnings when decorator cannot convert 3D to.

Quantification to consider Pset_ProfileMechanical.MassPerlLe.

Blender > Addon: Module Name
quantification fallback - small clarification

typing A
black . 3

Name or the symlink that is created in Blenders addon folder

Issue #5130 fix + sheet all expand and contract (#6379)

Fix #6372. See #1227. More reliable layer slicing. Always slice ...
See #1227. Clear cache when activating drawings. 1 Moul
get_shape_aspects to consider element's type #6374

Fix Ul errors in case of uppercase unit names (7af6727).

The new branch is created and we can see it in the bottom left corner of the VSCode
window.
expan
Fix #6372. See #1227. More reliable layer slicing. Always slice ...
See #1227. Clear cache when activating drawings.
get_shape_aspects to consider element's type #6374...
IfcOpenShell (Gi
§° DOC_QS_IDE* & | i?f(fﬂ R
e. Publish the branch to our project fork in GitHub by clicking in the publish button (little
cloud with up arrow) in the bottom left corner of the VSCode window. Select as origin the

Publish Branch !s€ unit names (7af6727)...

\
t)

project fork

) File Edit Selection View Go Run Terminal Help
o publish the branch "DOC_QS_IDE" t

SOURCE CONTROL origin_ https://github.com/falken10vdl/IfcOpenShellgit

> CHANGES upstream ! hell : !
\ GRAPH [ IfcOpenshell 39 Auto 3 ® 0 ~+ Add a new remote. 13 Settings Found Y
Fix Blender 4.4 errors starting some o DOC_QS_IDE & N

v - Gl User  Workspace Backup and Sync Settings
The experimental cutting tool now supports a bisect mode fo...

M fix to cll ; f th t
inor fix to clipping planes if there is no camera Dion Mout « Extensions

See #6404. See #1227. Create axis context f it does not exist .. - Blender: Additional Arguments
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall Additional arguments used for Blender start-up. List of strings.
Some form of circle handling in loop_to_function_item_upagr..

Apply skew in infra lofts #6386

python-expr
import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tooll
ISSUE #6328 fix in dispatch_token to avoid missing unknown ..

Retrieve length unit info from underlying mapping in iterator . Add Item

ifcsverchok - ifc.write_file_panel to filter .ifc files An

node.sv_ifc_create_file_refresh - fix LB Out bl_label ’

Blender > Addon: Build Task Name
ifcsverchok - remove debug print Andr

Task that should be executed before the addon can be loaded into Blender.
node.sv_ifc_tooltip - hide title A

typing A
Read settings from argparser

pyodide demo: install shapely Th Blender > Addon: Extensions Repository

Update publish-pyodide-demo-app.yml Th
pdatep Py mo-app-y Blender extensions only: repository to use when developing addon.

Update wheels #6402 Thomas Kr Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)
Blender 4.4 - fix broken Ul lists #6396

Implement readable setting type retrieval Thomas Kri scode-developrent
Reinstate old bespoke model-offset/rotation parsing in IfcCo..

Normalize model-rotation quaternion Thomas Krij Blender > Addon: Just My Code
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Fix missing default value for *last_commit_date" (37ec2bf) .
Use explicit "bl_ui_utils.layout™ import to fix #6389... Anc

debugging docs - add section about debugging addon Andrej.. Blender>/Addon:Load Directory

|} e T e e (e e Directory that contains the addon that should be loaded into Blender
See #1227. Fix bug where unjoin walls didn't recheck the posi. p—
Fix #6318. Fix warnings when decorator cannot convert 3D to..

Quantification to consider Pset_ProfileMechanical.MassPerLe..
Blender > Addon: Module Name

® quantification fallback - small clarification

Name or the symlink that is created in Blenders addon folder.
typing Andrej73(

black.. Andrej73( OBLEN B el
® Issue #5130 fix + sheet all expand and contract (#6379)...

Fix #6372. See #1227. More reliable layer slicing. Always slice ..
® See #1227. Clear cache when activating drawings. Dion Moult

get_shape_aspects to consider element's type #6374..

Fix Ul errors in case of uppercase unit names (7af6727)

Check that the branch is now in our project fork in GitHub.

B O falken10vdl/IfcOpenShell X  +

« > C O 8 https://github.com/falken10vdl/IfcOpenShell

% AlmaLinux % Documentation ' Blog ‘% Bug tracker ‘% GitHub organization
— O falken10vdl / IfcOpenShell

<> Code 11 Pullrequests () Actions [ Projects [ Wiki () Security |~ Insights  £83 Settings

@ I1fcopenshell 2 en | (@watch 0 ~

forked from

¥ v0.8.0 ~ ¥ 2 Branc Go to Add file ~ <> Code ~ About
Switch branches/tags Open source IFC library and geometry
S /0.8 19 Contribute ~ O Sync fork ~ engine

Q Find or create a branch..
00 Readme
e operators IfcOf f2283e5 go 0 17,506 Commits
Branches = Tags pera O

) Activity
v v0.8.0 default Update publish-pyodide-demo-app.ym yesterday

0 rs
DOC_QS_IDE migrate docs urls months ago e
0 watching

View all branches bonsaibim urls 7 months ag 0 forks
cmake Don't allow empty sha for add_commit_sha 2 months
Releases
conda bonsaibim urls I 7 months R
o releases published
docs docs: include doxygen-awesome as git submodule 1 months ag

nix Update build-all.py; --force fetch t last mc Packages

pyodide wasm wheel fixes 2 months ago MO PEEE

Languages
Unify variant storage ( I 7 months ago

win Fetch boo om github releases in build scripts 2 months ago b CH+76.2% Python 20.1%
C2.6% Gherkin 0.4%
.clang-format g-format: remove duplicates from base style 2 years ag ® javaScript 0.2% @ SWIG 0.1%
® Other 0.4%

-
[
[
.
.
B src Blender 4.4 errors starting some operators I 1 hour ag
[
.
B
b

.clang-tidy clang-tidy: add basic

f. Make changes in the code. In this case we will change documentation by adding a
Quickstart for the IDE in Windows. :)

/ UNTITLED (WORKSPACE)
© IicOpenshell Pull Reque . In the previous steps we got a complete IDE to explore and make changes to the Bonsai sourcecode
s Create a new branch in our local repository by clicking in the current branch name in the bottom left corner of the VSCode window. Give a name to the branch and press Enter

+ bonsai mage: : images/new-branch-local.png

v docs dth: 1688 px

v quickstart

Publish the branch to our project fork in GitHub by clicking in the publish button (*Little cloud with up arrow*) in the bottom
left corner of the VSCode window. Select as origin the project fork

e

onsai_style_annotation.svg
mage: : images/new-branch-publish-to-private-github.png
$ dev_environmentsh hi 1009 p:

Check that the branch is now in our project fork in GitHub

inage:: images/new-branch-in-private-github.png
1000 px

Make changes in the code. In this case we will change documentation by adding a Quickstart for the IDE in Windows

age:: images/make-changes.png
th: 1000 px

£. Comit the changes
First provide your user name and email to Git

s bonsai style annotationsvg inage: : images/git-user-enail.png

- idth: 1000 px

2025-03-27, 20:42


http://localhost:8000/_images/new-branch-publish-to-private-github.png
http://localhost:8000/_images/new-branch-publish-to-private-github.png
http://localhost:8000/_images/new-branch-in-private-github.png
http://localhost:8000/_images/new-branch-in-private-github.png
http://localhost:8000/_images/make-changes.png
http://localhost:8000/_images/make-changes.png

Windows - Bonsai 0.8.2 documentation http://localhost:8000/quickstart/ide/windows_ide.html

g. Commit the changes.

First provide your user name and email to Git.
TERMINAL J E‘

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.email
PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.name

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>

Then commit the changes by clicking in the check mark in the Source Control tool.

] File Edit Selection View Go Run Terminal Help

SOURCE CONTROIL

v CHANGES

Add quickstart for Windows |DH
@ v Changes

Accept the staging of the changes prior to commit.

Visual Studio Code

There are no staged changes to commit.

Would you like to stage all your changes and commit them directly?

Never Always Cancel Yes

h. Push the changes to our new branch in the github project fork.

) File Edit Selection View Go Run Terminal Help <« IfcOpenShell

NTRO £ indexrst X

CHANGES - src > bonsa £ index.rst
> IfcOpenShell ¢ $° DOC_QS D) oo builder html and (not singlehtml)

er:: toc-cards
input

HLs . = ntair global-index-toc
> mvd d
svgfill - octre

Sample-BIM-Files
Quickstart

2

quickstart/introduction to bim
cityjson ¢ a9488c8d O 50 - quic t/installation
quicks explore_model

Check that the changes are in the project fork in GitHub. You can see that the directory ide
has been added, for example.

— O falken10vd| IfcOpenShell

Code 1% Pullrequests () Actions [ Projects [ wiki Security |~ Insights {3 Settings
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quickstart

. falken10vdl

This branch is

B github
| aws
8 choco

i1 Contribute ~

> @ cmake
B conda

& Sync fork ~

http://localhost:8000/quickstart/ide/windows_ide.html

0
|

Add file ~

{9 History

8 docs

ide

> BB nix
B pyodide

images

] create_model.rst

v [ src
> @ bcf
v [ bonsai

> [ bonsai

1 explore_model.rst

installation.rst

] introduction_to_bim.rst

> [ build

9 next_steps.rst

i. Create a Pull Request to the upstream main branch of the IfcOpenShell project. Go to your

GitHub page and you will see that the new branch has 1 commit ahead of the upstream

main branch. Click in the Compare & pull request button.

<« > C

= O falken10vdI

> Code

IfcOpensShell

1 Pullrequests  (») Actions

@ IfcopensShell

forked from

¥ DOC_QS_IDE had recent pushes 36 minutes ago

B Projects

¥ DOC_QS.IDE ~

This branch is

O B https://github.com/falken10vdl/IfcOpenShell/tree/DOC_QS_ID

0 wiki  © Security 7 Insights

2 Settings

52 Pin

Compare & pull request

{1 Contribute ~

@ falkentovdl Add

t + <> Code ~

O Syncfork

O 17,507 Commits

® Wwatch 0 ~

About

Open source IFC library and geometry
engine

o

s f

Verify that the changes are correct, add a description and click in the Create pull request
button.

€« > C

— O IfcOpenShell

> Code

IfcOpensShell

© Issues 962 11 Pull requests

Comparing changes

t

T3 base repository: IfcOpenShell/IfcOpenshell ~

O B https://github.com/IfcOpenShell/IfcOpenShe

32

base: v0.8.0 ¥

() Discussions ») Actions [ Projects

«

head repository: falken10vdIl/IfcOpenShell ¥

0...falken10vdLl:IfcOpenShe

w2

2 0 wiki

compare: DOC_QS_IDE ¥

) Security

~ Insights
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. Add a title

Add quickstart

Helpful resources

Add a description

Write

This is documentation with all the steps required to implement a simple yet powerful IDE workflow to work with Bonsai
Sourcecode

£ Markdown is supported (2] Paste, drop, or click to add files

¥ Allow edits by maintainers Create pull request -

CONGRATULATIONS! You have now made a change in the Bonsai project and created a Pull
Request to the main branch of the project. Happy coding and documenting!

Copyright © 2020-2024 IfcOpenShell Contributors
Made with Sphinx and @pradyunsg's Furo
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